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FastStone Image Viewer is a favorite of many apps in Russian language for viewing, converting, and to some extent image editing. The latest version of FastStone is distinguished by fast and stable work, friendship with all popular formats, as well as simplicity and thoughtfulness. Very often this application is used as an alternative to the
built-in utility that is used for this purpose in Windows. The first thing to note is that the program allows you to view images in several modes, which allows you to choose the best for yourself. So, available full-screen, window, as well as slideshow mode. In addition, it is worth noting the other advantages of this utility: the ability to turn
pictures into book-like; support for all popular formats, where images are stored (GIF, JPEG, ICO, ICO, TIFF, etc.); support for a professional format such as RAW, which is valuable for high-quality photos (the program is able to open such images very quickly); all important and popular features are always at hand; look for the right image
in the folder is very convenient; the viewable image can be instantly printed or installed as a desktop wallpaper; to edit images, the ability to trim, rotate, resize, clone, etc.; ability to eliminate the red eye effect; adjust brightness, color, contrast; a set of handy, intuitive hot keys to faster control the process. frames, visual effects, stencils and
the like. Directly on the image you can apply watermarks or even draw on top of the picture. Separately, it's worth mentioning the possibility of using 156 different effects to move between slides when creating a slideshow. Free to download FastStone Image Viewer is also worth it because the program provides ample opportunity for further
use of processed images. You can easily email them or print them out. Download the FastStone Image Viewer for free from our website andprog.ru on Russian windows 7, 8, 10 windows and enjoy quick graphics processing. Version: 7.5 Final Size: 7.17 Mb System: Windows Android Developer: FastStone Soft Language Interface:
Russian Status Program: Free; Download freeFastStone Image Viewer for Windows; Download freeFastStone Image Viewer for Android Appreciate this program please! 9 Rating: 4.11 Join our VKontakteMeet group: GraphicsMultimes 1 2.4.6 3.85MB 1 2.4.4 3.56MB 1 2.4.4.2 2 3.56MB 1 2.4.0 2.58MB 1 2.3.2 2.39MB Image Viewing for
Android Official Website October 28 Free Home Software - License only for personal use (for non-commercial purposes). Learn more... Supported formats: BMP, JPEG, CUR, GIF, ICO, PNG, EPS, PSD, CRW, CR2, DNG. The FastStone Image Viewer is a free program to view the image. The app has a standard interface that includes: a
folder tree. sketches of image files. menu for quick access to basic features. The feature of viewing a single image is the ability to view it across the entire screen, with the ability to zoom in on individual parts. It helps the smallest details. To compare images, it is possible to display them simultaneously and to compare details. Features of
the program For a quick renaming Of a FastStone Image Viewer has a group renaming feature. For files, you can set of course the name in the form of a mask I use the date, the file number, the name of the folder. The next feature is to create a slideshow. It will be in the form of an EXE file, so it will start on any computer. There are a
number of settings to set up the slideshow. You can view them in the image below: To work with the image, the program includes a number of standard features: Changing size. Trim. Color correction. Here are the color-correction tools: FastStone Image Viewer Summary is a good image viewing program that incorporates basic image
processing features. 04 February 2016 - Up Fast Image Viewer - view of many types of images and even animated gif pictures Telegram-channel creator Treshbox pro technology approximation multitouch recent pictures viewing animation without opening the picture (i.e. when scrolling through the list of pictures) sending images showing
the full information about the file Telegram channel creator Treshbox pro technology Game of the Day Game Game Game Mouse Hero Hero Hero , stable, user-friendly image browser, converter and editor. It has a nice array of features that include image viewing, management, comparison, red-eye removal, emailing, resizing, cropping,
retouching and color adjustments. Its innovative but intuitive full-screen mode provides quick access to EXIF information, thumbnail browser and major functionalities via hidden toolbars that pop up when your mouse touches one of the four edges of the screen. Other features include a high quality magnifier and a musical slideshow with
150+ transitional effects, as well as lossless JPEG transitions, drop shadow effects, image annotation, scanner histograms and more. It supports all major graphics formats (BMP, JPEG, JPEG 2000, animated GIF, PNG, PCX, PSD, EPS, TIFF, WMF, ICO, CUR and TGA) and popular RAW digital camera formats (CR2, CR3, CRW, NEF,
NRW, PEF, RAF, RWL, MRW, ORF, SRW, X3F, SRW, SR2. No Adware. No spyware. Free for home users Version 7.5 2020-03-10 What is the new browser image features and viewer with familiar Windows Explorer-like user interface Support many popular image formats: True The viewer's Full Screen with convenient image scalability
support and unique menu panels fly out crystal clear and customizable with a single click image magnible Powerful image editing tools: Resize/resample, rotate/flip, trim, sharpen/blur, adjust lighting/colors/curves/levels, etc. Eleven re-sampling algorithms to choose from when changing the size of images Color effects : grey scale, sepia,
negative, red/green/blue adjustments Images special effects: drop shadows, framing, bump map, sketch, oil painting, lens draw texts, lines, highlights, rectangles, ovals and callout objects on images of Clone Stamp and Healing Brush Red-Eye removal/reduction with a perfectly natural look the end result of the Multi-level Undo/Redo
Including tagging files and drag-and-drop to copy/move/retoze Histogram display files with color counter feature Compare images side by side (up to 4 at a time) to easily cull these forgetful images Image EXIF metadata support (plus commentary editing for JPEGs) Customized batch processing to convert/rename large or small
collections of Slideshow images creating with 150 transitional effects , WMA, WAV...) Create effective image attachments for email for family and friends Print images with full page layout Create fully customizable contact sheets Create memorable art montages of images from your family photos for personalized desktop wallpaper
(Wallpaper Anywhere) Acquisition of images from the scanner. Сканирование пакетов поддержки на PDF, TIFF, JPEG и PNG Универсальный экран захвата возможности Мощный Сохранить Как интерфейс для сравнения качества изображения и управления генерируемый размер файла Запуск любимых внешних
редакторов с одним нажатием клавиши изнутри Image Viewer Предложение портативная версия программы, которая может быть запущена из съемного устройства хранения Настраиваемые мыши колеса поддержки темы поддержки (яркий, серый и темный) Поддержка Touch Interface Support (click, swipe, pinch)
Support double copies of Play Story Version 7.5 (March 10, 2020) Added a dark (almost black) theme. Now there are 3 themes (Bright, Grey and Dark) in the Settings menu Added support for audio formats that can be included in the video tab Window Settings Many others Improve and Fix Bugs Version 7.4 (August 28, 2019) Improved
clone and healing. Transparent Images is being supported by Improved Pencil in Draw Board draw a smoother line Fixed bug that can fail the program when changing the browser from submitting details to thumbnails of vision Fixed the problem of launching Google Maps Other minor improvements and bug fixes Version 7.3 (June 21,
2019) Fixed the error that caused a copy and insertion of the failure in the design and printing version 7.2 (June 14, 2019) FAX supports, Supports FAX, JFIF Formats and TS Improved Processing Speed (5X Faster) Batch Rename Fixed bug that failed to download some images of TIFF Other improvements and bug fixes Version 7.1
(May 28, 2019) Supports HE IC and WEBP formats on Windows 10 Added Lens Model to EXIF Improved Color Accuracy When Downloading IMAGES CMYK jpeg Improved Stability when Processing Damaged or Evil Images Other Improvements and Bug Fixes Version 7.0 (March 22 , 2019) Supports color profile monitoring. You can
include this option in the CMS Settings tab Supports various (bright or dark) skins for double instances Improved compatibility with various scanners Fixed vulnerability, which can cause program failure on damaged or malicious images Other minor improvements and bug fixes Version 6.9 (January 23, 2019) Added support. M2TS video
format Added shortcut (Alt'I) to show File Properties Fixed copy and insert bug in miniature browser Other minor improvements and bug fix version 6.8 (January 14, 2019) Added a multi-read support for the built-in batch convert tool. Now it can handle multiple images simultaneously (FASTER) Added version of Auto-deskew to the
scanning tool Many other minor improvements and bug fixes Version 6.7 (October 30, 2018) Improved Performance : Download files TIFF Update changes to the current folder Activation amp added Magnifier and Boost and No Action for Mouse Click list in settings Added the ability not to attach _cr In the name of the file while saving files
in crop board Added the option of using the external file as an image source in the library format Clone and Heal Updated RAW with the support of CR3 Improved support interface Touch Other minor improvements and bug fixes Version 6.6 (September 19, 2018) Improved performance: Download images faster Open large folders faster
Copy / Move files faster Process embedded ICC profiles faster. Now the built-in support for the ICC profile is enabled by default Added a new mouse gesture to the zoom image. When the mouse is in the enlarged Press and hold the mouse button to activate the magn with a magn with. Release the mouse button to hide the magnified
mouse button with one click to zoom in and view the image in real size (100%). The internal video player option is an automatic playback of the current video file Option for the cycle of the current video file In full screen mode, auto-show play bar when moving mouse Auto-show hint at the time of position when hovering mouse on the
progress button Advanced package convert / rename tool. Now the Filename template is not required, now you can expand the canvas by pixels or by percentage Added swap colors in the Menu Color Fixed bug associated with DPI, in Contact Sheet Builder Other minor improvements and bug fixes Version 6.5 (May 02, 2018) Improved
tool imported photos and videos. Now it allows you to import both photos and videos from mobile phones, digital cameras and card readers. Previously, video files could not be imported. Improved internal video player increased the maximum time interval (from 5 minutes to 1 hour) in slideshow Other minor improvements and bug fixes
Version 6.4 (September 12, 2017) Improved internal video player and scanning tool, used as a key for tags/non-files used by Ctrl-Shift-D as the key to the shortcut to turn on/off the preview on the secondary monitor when the Folder launch is set by default, you will be able to auto clear the history of the visited folders Other minor
improvements and bug fixes Version 6.3 (July 28, 2017) Added internal video player that: Remembers the last position of Auto-plays next video when the current video ends Playing video in slideshow Note: We do not provide video codeks. Third-party codeks may be required for older versions of Windows Improved rendering of
annotations in draw Tool Improved support for high bit-stakes mp3 in slideshow Other minor improvements and bug fixes Version 6.2 (February 17, 2017) Dialogues processing packages can be as much as possible supporting the mouse forward/back button Supports F11 key to switch between full screen and window mode Improved
algorithm to convert into 1-bit color depth Improved memory control to handle large images Other minor improvements and bug fixes Version 6.1 (December 23, 2016) Improved download speed JPEG Added support for TIFF compressed images on zif, added the Signature option to the Design and Print tool. Now you can print properties
such as file name, date/time, measurement below image Added File Name Option Image Strip Builder tool Improves text printing quality in Contact Sheet Builder tool Other minor improvements and bug fixes Version 6.0 (October 28, 2016) Improving the straightening/rotation tool. Now you can rotate and crop the image in the same
Window Added Auto option Folder to the Viewer Settings tab. This option allows you to move on to the next folder automatically when the end of the current folder is reached. In addition, you can press the Alt keys - left/right arrow at the beginning/end of the current folder to go to the adjacent folders added to the last viewed file to view the
view From Settings Added Two Increase Filters (Lanczos_Softer and Bilinear) to view the Settings tab Added full screen Preview to Culture Tip Added update of the Timestamp file option, to save as a dialogue Added copy of the image (Ctrl-Shift-C) in the menu of the right click on the sketches Added copy to Clipboard to Image Strip
Builder Other minor improvements and bug fixes Version 5.9 Now you can automatically rotate the image by tracking the line along the edge of the building or the horizon Of the Improved Drag between double copies Other minor improvements and bug fixes Version 5.8 (August 26, 2016) Supports double instances. Now you can run two
images of viewers at the same time, drag and drop images between them, and compare images from different folders side by side Added the ability to show/hide file names while comparing images Added the right click menu in the EXIF list to copy EXIF in Clipboard Displays MP4 and MOV sketches on Windows 10 Updated Raw format
library Many other small improvements and bug fixes 2016) Improved Dark Skin Fixed Some Bugs Version 5.6 (May 20, 2016) Added support for high-resolution monitors / 4K Optimized Effects Transition to Slideshow Improved Compatibility with Windows 10 Many other small improvements and bug fixes Version 5.35 (August 14, 2015)
Fixed an error that failed to display file properties (size, type and date changed) in the Conversion/Renaming Tool Version 5.4 (July 31, 2015) added support for single-code file names across the software. Now you can view and process images named in different types of characters (e.g. Arabic, Chinese, Greek, Japanese, Korean,
Russian...) Added support for the symbolic links Improved Convert package, Crop Board and Draw Board Many other improvements and bug fixes Version 5.3 (October 24, 2014) Optimized program to support large images Fixed error that can lead to a snooker program when you press the W key to open the containing folder Other small
improvements and bug fixes Version 5.2 (September 24, 2014) Now you can copy and paste objects in draw board Added Zoom in center/mouse position in settings Added Smart-Filling to Advanced Options (Resize Tab) from the Package Conversion Tool Added Fit Width (Shift-W) and Fit Height (Shift) to the Menu Increase Improved
Copy/Move To Folder Tool. Now you can click from 1 to 9 to select a pre-defined destination folder Many other improvements and bug fixes Version 5.1 (March 11, 2014) Now the Batch Rename tool supports all kinds of files if you choose All (c.) in the list of file filters You can now press the keys to zoom in/ from animated GIF files Fixed
bug, causing the program to lose count of the current folder when it comes out of full-screen Version 5.0 (February 28, 2014) Added crop fit to Full Screen option to the Slide Show Larger Sketch Size (260 x 195 Pixels) to Thumbnail tab in settings (click F12) Added shortcut (Ctrl-Alt-A) for Auto-turn-based TEG ORIENTACIA EXIF Can now
use the Do Not Change size option, if the image is already smaller than the size requested when the picture is package-sized based on one hand Now you can tag or untag the image, even when the magnifyer is activated Other small improvements and bug fix version 4.9 (November 12, 2013) Added Design and Print (click Alt-P), which
allows you to print multiple images with text and effects on one page Improved Adjust Curves. Now you can click and drag the image to adjust the curves directly. The endpoints of the curves are adjusted added to the print size option to the Resize package tab converts the Added Video File Support tool into a package renaming tool
Added Auto-Resize option to the image scanning tool Added to the Show button in Google Maps and Show in Google Earth to the Image Properties window. These buttons will be visible if the image has GPS information Many other small improvements and bug fix version 4.8 (April 4, 2013) Added the Mini button (hidden in the top right
corner of the screen) to the full screen mode. Now you can minimize application to the taskbar without leaving full screen mode Added two variants of the click mouse use left/right clicks for previous /following images Improvement draw Board. You can now draw curved strings Improved Dialogue Print Other improvements and bug fixes
Version 4.7 (January 28, 2013) Added touch interface (click, swipe, pinch) support throughout the app Added a new mouse gesture to move between images: Click at the bottom of the preview window to switch to the next/pre-image Improved Copy/Movement Dialogue. Now it shows the image comparison window and allows you to select
Replace, Skip and Rename when processing files the name of conflicts Added option to allow you to manually choose which photos to download in the Download Photos tool Improved Print Dialogue Added a new browser mode (in the Menu View-zgt;Layout), which provides a larger viewing area of images Added tool Reduce Noise
Improved Straightening/Dialogue. You can now save the side ratio when turning the image of the Improved Tool Set Wallpaper anywhere on the desktop with Drop Shadow and Cut Effects Improvement Text tool in Draw Board. You can now see a preview of the fonts in the Improved Crop Board font name list, adding the Original Ratio to
the Paper Ratio Improved Image Comparison, adding the option to Auto-Fit The Windows Improved Navigation Folder in Windows Libraries Has updated the RAW library format. Added support for SRW, NRW, RWL files. Added option in Raw Tab Settings for Turn/Off Raw Files Added New Skin called OSX Many other minor
improvements and bug fixes Version 4.6 4.6 29, 2011) Improved Purchase Images from scanner tool Other minor improvements and bug fixes Version 4.5 (April 12, 2011) Now you can customize lighting, colors, levels and curves in selected areas of the image Fixed errors in print and email dialogues Version 4.4 (March 25, 2011)
Improved Image Images Scanner from (formerly called Scan). It now supports the PDF, TIFF, JPEG and PNG scanning package. This allows users to rotate, trim, deskew, annotate, print, email and save scanned images directly within this tool Added Watermark to the Effects Menu Added Auto-Turn Option Print Dialogue Added Drag and
Drop The Ability to Print Dialogue Improvement Dialogue IMPROVED USM-Sharpen Algorithm, Allowing up to 50 pixels in the radius Of Improved Full Screen Preview Can now make adjustments to full screen-fixed bug mode in the Adjust Lighting tool that it could not save changes To other minor improvements and bug-fix version 4.3



(January 14, 2011) Added clone stamp and healing brush Added Auto-Tune colors to the color menu. THANK YOU Andras Horvath: www.log69.com Added Adjust Lighting to lighten or darken shadows and highlights added Adjustment Levels Added Adjusted Curves Added USM (Unsharp Mask) version of Sharpen/Blur Added Sketch and
Oil Painting Effects Added outwardly pointing tails to text objects in Draw Now Image in Slide Show Builder, The multi-page File Builder, Image Strip Builder, and email list can be dragged and discarded to change the format of the EPS-supported PAX-supported RES preview image by displaying a preview image of the updated RAW
library. Sony SR2 crude format supported improved memory management to handle large images Other minor improvements and bug fixes Version 4.2 (April 29, 2010) Now you can package convert images into PDF files Improved amplifier Optimized download speed Windowed View Fixed some errors, introduced in version 4.1 Other
minor improvements To Version 4.1 (April 19, 2010) Improved JPEG image download speed and built-in preview of RAW images Improving rendering quality, When the Smooth Option Included Advanced Contact Sheet Builder Added Auto Vintage in the Turn Window Added more call styles to Draw Board Added Settings option (click
F12) to indicate location (top or bottom) to display information about file imimimins on full screen Other improvements and bug fixes Version 4.0 (November 19.0, 2009) Improved skins and tools. Now the windows have a drop shadow effect in Vista and Windows 7 Added Search and Replacement for batch Added Renaming Preview in
Batch Rename Advanced Conversion Preview in Batch Convert. Now you can compare the original and converted images side by side in Advanced Options for Batch Convert, added an option to indicate whether the color is color (brightness, contrast, imprisonment, etc.) must be made before or after the size. Shows GPS information in
the Image Properties window. The Show button in Google Earth will be available if the image has GPS information Added Border Effects in the Edit Menu Added the ability to delete EXIF/IPTC data removal when email images Added shortcuts for your favorite folders Improved Performance on Network Folders Improved Compatibility with
Windows 7 Fixed Errors Other minor improvements Version 3.9 (June 8, 2009) Improved Multi-Page File Builder Insert and Cut in the menu of the right click on the browser folder Improved file selection performance in the miniature browser When dragging sketches, you can now undo the drag by clicking esc key multi-page TIFF files can
be saved as multi-page PDF files Added 2 Languages: Czech and Swedish Fixed Errors Other minor improvements To Version 3.8 (April 27, 2009) Can now be made callout (April 27, 2009) , oval, rectangular...) Objects in Draw Board Translation of the user interface to 15 languages Added the number of copies in the Print dialogue
Added color intake option (also called Chroma Subsampling) to save JPEG files, Optimized to improve performance Fixed error in version 3.7 that the program can not automatically update when viewing files in the network folder Fixed error in previous versions that the program can not view animated GIF files with a zero frame delay time
Other minor improvements To Version 3.7 (January 20, 2009) Added preview to the Batch Convert tool. You can now view the conversion by clicking the Conversion Preview button added a box to allow converted files to be stored in the original folders in the Batch Convert Advanced Cover style tool set as wallpapers. Now you can zoom
in and drag an image to set any specific part of it as wallpaper Now you can set up TIME EXIF by hours and minutes using the Timestamp Change tool in the Tools menu Added option to Settings to determine what (move or copy) actions to take when files are dragged into the Advanced Magnifier tree folder to view large images faster
than the updated RAW format of the library. Panasonic RW2 files supported Fixed some bugs Version 3.6 (September 15, 2008) Now it works on both 32-bit and 64-bit Windows It plays video files (avi, wmv, mpg) in a slideshow Can show EXIF/Histogram information and work on sketches at the same time. Simply press the I to turn the
Image Properties Window On And. sort of files in the Added Expand Mode option to the Canvas Window Advanced Options tab You can now drag and reset files from Windows Explorer to the Add-on List of Draw Board (according to the editorial) edition) Now annotation of objects (texts, lines, boxes, etc.) can be edited by reopening draw
board (click D) Added Animated GIF as a output option in Multi-Page File Builder Added Multi-Page Splitter File (under Menu Creation), which is used to separate the multi-page File on individual files Added Image Strip Builder (according to the Create menu), which is used to put multiple images side by side 2008) Added a comparison of
Side by Side in Color Improvements Added Line Highlighter's Draw Board Advanced Text Tool in Board Draw. Now Shaded Text Possibly Added Boundary Effects in Batch Convert Optimized Algorithm for Text and Watermark's Batch Convert Updated Raw Library Format Restored Skin called Steel, which was removed in the previous
version Of Some User Interface Improvements and Bug Fix Version 3.4 (November 7, 2007) Added RGB adjustment to Improved Colors Added Option Batch-convert RAW files in the RAW Settings Tab Added Wallpaper Builder to Create Menu Improved Fonts Menu Advanced Built-in Party Conversion Tool Added Leather with Vista Look
and Feel Fixed Some Errors Version 3.3 (October 23, 2007) Added Improvement of the color range, contrast and saturation of the image Improved Sharpen/Blur Added Obscure (Blur) in the Edit menu that can be used to obscure confidential information in the image Added new option Remind Me to save changes in settings. Cancel this
option if you don't want a pop-up message do you want to save the changes made to this image? Allowed image tagging in the slideshow Added Slide Show Builder (in the Creation menu), which allows you to save slideshows, including image and music files, in one exe file that can be played on other computers without FastStone Image
Viewer Extended Download Photos tool. Now you can get photos from both cameras and card readers via USB Advanced Change timestamp in the tool menu. Now it allows you to change/set the date when the photos were taken added to delete JPEG metadata in the tool menu. This allows you to remove metadata such as EXIF, IPTC,
embedded sketches, etc. from the jpeg files Added Show Histogram version of the Image Comparison Tool Advanced RAW Library. It is now recommended to view RAW files using the built-in preview image for faster performance (see RAW tab in Settings) In the image comparison tool, you can now pan with arrow keys Other small
improvements in the user interface Fixed some bugs Version 3.2 (April 23, 2007) Added version print page-only print dialogue Improved twist of any degree Fixed some bugs Version 3.1 (April 16, 2007) Created a multilingual version of The Improved Library Raw Improved Navigation (page (page from multi-tiff files Fixed some bugs
Version 3.0 (February 16, 2007) Compatible with Windows Vista Added a new version of the slideshow Auto-Play Folders, which allows you to play a slideshow through several folders Added multi-page Builder file that can combine multiple images in one file (PDF or TIFF format) Improved support Multi-TIFF Page (view, view, Print,
Preservation) Support the PDF format in Save As Dialogue Support cropping images in batches (in built-in converter package) Using EXIF date/time (if any) in batch renamed Fixed Version 2.9 (January 18, 2007) Advanced Board Draw (formerly called Text Board) Added Download from the Memory Card. You can now use the FastStone
Image Viewer to transfer images from the digital camera memory card to your computer added new frame masks to wallpaper anywhere - thanks to Albert Hansen and Lou Wei Fixed some bugs Version 2.8 (October 25, 2006) Completely new design icon Improved usability Fixed some bugs Version 2.7 (October 18, 2006) Improved
magnifying glass in full-screen built-in screen Capture tools are back (they were removed in previous versions) Added Builder contact sheet (according to the toolkit menu) - put/print several photos on one page. Fully customizable! Added custom variety - drag and drop to organize sketch orders (For better performance, turn off the
preview panel) You can now drag and drop sketches in sub-dads in the browser sketch Fixed some bugs Version 2.6 (July 19, 2006) Add wallpaper anywhere (according to the tool menu) that allows you to put photos anywhere on your Windows Desktop Can open all selected files in the external program at a time (Click E key) Double
Monitor support (see Double Monitor settings Now you can: Drag and drop the main window for any of the Display thumbnail browser monitors and the full preview screen through two monitors simultaneously display slideshow in secondary monitor Version 2.5 (April 21, 2006) Add the Overlay button (right to left) button in the Compare
images window that helps determine any small difference between the two images Add the Compare button to the full screen in the Compare Images Window Improvement Support Scanner in the Scanning Board (click Alt'S). You can now specify the value of the DPI scanner before scanning the filename sorting now using The Natural
Variety. For example, file name order in: This version: File1.jpg, File2.jpg,... File10.jpg, File11.jpg Previous version: File1.jpg, File10.jpg, File11.jpg,... File2.jpg Thumbnail Order is remembered when you switch folders; Add an option to turn on/ Preview box in the browser View Support Images Tagging (in the Tag menu can now be tagged
through a large number of photos on the full screen by clicking I key You can filter out unegueable files and focus on (copy/move/edit/slideshow, etc.) labeled of them only Image tagging options can be found found Thumbnail Settings tab (click F12). It can be disabled when the Option Allow Image Tagging is an uncontrolled Tag Image in
compare image box (click P key) Fix minor error Version 2.4 (March 15, 2006) Now the built-in screen capture supports the multi-monitor system Video files (AVI, MPG, MPEG, WMV, MOV) can be displayed as sketches in the browser. Double tap on video file will open it in the default media player Add Text Board (click T key), which
allows users to draw the following objects on the images: Text Freehand line arrow line Ellipse Watermark Add option to display Rule thirds in Crop Board (click X key) Other minor improvements To Version 2.30 (February 10, 2006) Add SRF (Sony Raw Format) support Improved rendering of raw images and add more compatibility with
new digital cameras Add Fit to Window Width and Fit to Window Height on the Auto Image Size option in settings (Click F12) Add mouse wheel option in settings (Click F12), you can now use the mouse wheel, to scroll up and down long graphics files Add Single File removed option in settings (Click F12) that has 4 options when deleting
the file : Recycle-Bin, Recycle-Bin Confirmation, No Confirmation No Recycle-Bin, Confirmation No Recycle-Bin, No Confirmation Add Image Position Option (0.0) when downloading images in settings (Click F12) Add two rotation buttons (turn and save) over the full screen thumbnail list (appears when moving the mouse You can now
press the C key twice to copy the key to move the file to another folder, i.e. click C to pop-up Copy in Folder, click C again to copy the file to the selected folder Other minor improvements Version 2.29 (November 25, 2005) Add The Settings icon on the toolbar Fix some errors that cause stability problems Version 2.28 (November 14, 24,
2005) Add Back to /forward buttons On the toolbar above the sketch browser Improved Navigation folder Add JPEG Lossless Rotate Selected images in the menu Tools Improvement JPEG Lossless Rotation - images optimized for smaller file size Add timestamp change to the tool menu , you can now set the file time as a date/time photo
taken (JPEG format only) Other minor improvements. 2005) Improvement support for the raw digital camera Add 5 RAW support format: - DNG (Adobe Digital Negative) - ORF (Olympus) - RAF (Fuji) - MRW (Minolta) - PEF (Pentax) Add the Copy/Move option to the window so that the destination folder can be created if it does not exist
Improvement EXIF table in the full screen option in settings (Click F12) to show hidden files and folders Add option in the Email-Image window, allowing images to be sent as a self-extracting EXE file (another option is the qIP file) qIP) In the color adjustment window (brightness, contrast, etc.) are remembered/saved for the next use Add
hotkeys Alt-2, Alt-3 ... For the second, third ... External Program Can Now use pgUp/PgDn/Space key to switch images to the magtel Now you can install a program for all users in the same computer Fix thumbnail targeting bug in CR2 and NEF formats Add Color Control (embedded ICC) support. To turn it on, go to the CMS tab in
Settings Add Scroll Navigator to the full screen (Move the mouse to the bottom edge at full screen) Improving the crop board (Click X key) to make it possible to trim multiple images (Crop to file) using the new Previous and Next Buttons Add Create Portable App Settings (Click F12). The portable version of this program can work
regardless of any folder you reset it in Lossless Crop Performance Improvement to file in Crop Board Add External Darkness Control to Crop Board Enhance Scroll Navigator (Move the mouse to the bottom edge at full screen) Fix some bugs and make minor improvements to Version 2.22 (August 25, 2005) Code Optimization Add option
in settings (Thumbnail tab) to disable The Thumbnail database Add option to settings (Association Tab) to show View from FastStone folder context menu in Windows Explorer When the displayed image is larger than the current available window or screen area, click Arrow (Up, Down, left, right) keys for panning/scrolling images in the
current window or screen area Add the option to squeeze images into one file (format zip) in the image e-mail function Fix the error in the animated GIF rendering of EXIF information display in the red Eye Image Comparison Window Improvement under Edit Menu Fix Other Minor Error Version 2.20 (August 10 , 2005) Add the Auto-Hide
mouse cursor option to the full screen Add sepia effect Save the last way used in copying/Move to add a copy to Folder, Move to Folder and Delete Buttons for Toolbar Add Option Database Location (see Thumbnail Tab in Settings) Fix the bug in animated GIFs Now it's easy to view the deterioration in image quality options can enter
during the process of saving Add settings in the settings (Thumbnail Tab) to customize the browser colors Add option to assign edit options with external program (see External Tab Programs in Settings) Code Optimization to handle large sketches file database more effectively Improving the crop board with mouse-enabled wheels (Zoom)
, you can now switch the folder to the folder in Full Screen using the folder tree Add option To Use JPEG from the original file, if possible (see JPEG tab in settings) Create different icons for different related related Formats Some other bugs corrected Version 2.15 (July 8, 2005) Support Canon CR2 Preview adding the default unit option to
the Skin Update Settings Add the Option Show Extension in Renaming (F2) Window Fix Errors Version 2.12 (June 10, 2005) Wrap Scrolls in a miniature browser using left/right arrow keys Optimization Add Code MacX Skin Fix Error Version 2.1 (May 30, May 30, 2005) Auto-full address bar User can choose browser mode / Full screen
mode / Window mode when double-tapping images from the explorer window, See Settings for Detailed Improvement of EXIF Processing in Save as Menu/Buttons Add Favorite Menu Improvement Copy in Folder / Move in Folder Support Auto-Rotate jpeg Images based on EXIF targeting tag Enhance JPEG comment, 2005) Paper crop
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